' Computer Part-7

Chapter-1 Introduction of Computers

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick (¥)the correct option:
a) b) Dboth(a)and(c)
b) a) software
¢) c¢) keyboard
3. Fillin the blanks:
a) Inputis known as raw information.
b) Processingis said to be the operation of data.
c¢) Output is the processed data given by
computer after data processing.
d) All physical parts of the computer are called
hardware.
4. Answer the following questions:

a) The Scanner enables us to create an
electronic form of printed image. Scanner
does is by shining a light on the image. After
image is scanned and transferred to computer
memory, the same can be modified as per
requirement. We can use Scanner to stock
photograph on computer or transfer a picture
from a book into your presentation.

b) QWERTY is a keyboard which was invented
by Christopher Latham Sholes in 1875. It
contains 104 keys.

c) The Input Devices accept inputs in several
forms from the user and change it into
understandable machine form. Input Devices
are: Keyboard, Mouse, Scanner, Bar Code
Reade, Joystic and Micro-Phone.

d) ByMouse, we meanapointdevice. Itisusedina
graphic environment like Windows Operating
System. It performs commands/instructions by
clicking on options, menus and icons. It contains
2-3 buttons.

e) Input Unit is formed by Input Devices
attached with the computer. Input Devices
accept inputs in several forms from the user
and change it into understandable machine
form. Input Devices are: Keyboard, Mouse,

Scanner, Bar Code Reade, Joystic and Micro-

Phone.

f)  The correlation between Light Pen and Touch

Pad s as follows:

LightPen : It is known as a pointing
device sensitive to light and
looks like a pen. It ensures
input moving directly on
computer screen. It sends
signals to CPU which
processes and carries out the
instructions.

Touch Pad : Itis known as a device to point
(controlling input positioning)
on computer screen. It is an
alternative to mouse. It is also
made for use with desktop
computers. It works by
sensing the user's finger and
movement.

Lab Activity:
Doityourself

Chapter-2 Microsoft Window - 7

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick(¥) the correct option:
a) 1) both b) c¢) Windows
c) iii) Copy d) a) Yes
3. Fillin the blanks:
a) We can open Windows Explorer directly
from right clicking Start Button and then
Clicking on Open Windows Explorer.
b) The Left Pane shows the Personalize and
Desktop Icons.
c) The Copy Optionis utilized to copy a folder.
d) The Back and Forward buttons are available
on the Toolbar.
4. Answer the following questions:

a) By Windows Explorer, we mean navigation
through Windows 7 folders and libraries,



b)

d)

preview content details and use keywords to

search for specific documents. To get to

Windows Explorer:

< Click on Start button — All programs —

Accessories —Windows. OR
< Right click Start button. Click on Open
Windows Explorer.

The various “Group by” options available to

arrange the contents of a Folder/Drive are as

follows:

It organizes Files and Folders by breaking

them into different sections as follows:

1. Name : It organizes Files and
Folders in alphabetical
order by their names.

2. Datemodified: It arranges icon in

order or modification
date.

3. Type : It organizes Files and
Folders according to
File type.

4. Size : It organizes Files and

Folders in order of
their file size.
CD Burning means to copy or write
information on to a Compact Disk :
We use Documents Library to arrange and
organize word-processing documents,
presentations, spreadsheets and other text-
related files.
< Click Start button
< Click Documents.
We view a Window and its various parts help
us navigate or work with files, folders and
libraries.
We can make Keyboard easier to use by
adjusting settings on Make Keyboard Easier
to Use page in Ease of Access Center.
Step1 : Click Start to Open Make
Keyboard Easier to use page
% Click Control Panel, Click
Ease of Access, Click Ease of
Access Center, Click Make
Keyboard Easier to use.
Step2 : Turn on Mouse Keys to run Mouse
keys ifyoulog onto Windows.

< Turn on Sticky Keys: It sets
Sticky Keys to run.

< Turn on Toggle Keys: It plays
an alert every time you press
Caps Lock, Num Lock or
Scroll Lock keys.

< Turn on Filter Keys to enable
them to run.

< Underline Keyboard Shortcuts
& Access Keys to allows
access in Dialog boxes easier
by highlighting access keys for
control in them.

< Present Windows bring
automatically arranged when
moved to edge of Screen.

f)  The various viewing options available to
view contents of a File/Folder are:
< Click the Start button and then click
Computer.
< ClickaDrivetoselectit.
< Review the Drive details in Details Pane.
< Double Click Drive to openit.
< Click Back or Forward button to Toolbar
to move or return to a previously visited
Window.
< Click on Close button, if you are done.
Lab Activity:
Doityourself
Chapter-3 Number System
Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick(¥) the correct option:
a) a) Binary
b) ¢) numberlanguage
c) c¢) Digital Computer
d a 2
3. Fillin the blanks
a) ThebaseofBinary Systemis 2.
b) Thebase of Hexadecimal Systemis 10.
c) Actual Number System consists of 2 digits.
d) InBinaryAddition, 1+ 1 equalsto 10.



4.

Answer the following questions:

a)

b)

d)

Actual Number System consists of 2 digits:
'0' and '1". This is also known as Base-2
Number System, because each position in the
number represents an increasing number
with a base of 2. This number system is called
Binary Number System.

The rules to multiply two Binary Numbers is
as follows:

0x0=0
0x1=0
1x0=0

1 x 1=1.Andno carry or borrow bits.
Since Binary works in Base 2, it involves 0
and only. We take example of binary
multiplication of 101 times 11 i.e.
101
x 11

We multiply 101 by 1 and get 101. We place 0
as a placeholder as we would in decimal
multiplication and multiply 101 by 1 which
gives 101.
101
x 11
101

1010 <--0hereisplaceholder

1111
The next step is to add. Results from earlier
step shows we must add 101 and 1010, the
sumofwhich 1111.
Thus (101),* (11),=(1111),
The Hexadecimal digits are base-16 number
system, because every position in number
represents an increasing number with a base
of 16.
They look same as Decimal Numbers upto 9,
but there are letters (“A”, "B, “C”, 'D”, “E”,
“F”)in place of decimal numbers 10 to 15.
A single Hexadecimal digit can show 16
different values instead of normal 10 as
following:
Decimal 0123456789101112131415
Hexadecima 0123456789ABCDEF
The steps to change a Binary Number into
Decimal Number are:

< Multiply each binary number with 2
having he power 0 for unitary position,
starting from extreme right digit.

< Increase power one by one, keeping the
base constant as 2.

< Add all products to obtain the decimal
number.

Example:

Change from binary to decimal: 111101 , =? ,,

111101

= 1x2°+0x2" +1x2°+1x2°+1x2'+1x2’

=1+ 0+4+8 +16 +32

=61,

e) To change a decimal number to Binary, we

will follow do as follows:

To convert a decimal number to binary, first
subtract largest possible power of 2 and keep
on subtracting the next largest possible
power from remainder, marking Is in each
column where this is possible and Os where it
isnot.

Example: (Convert Decimal 44 to Binary) or
(44, t0?,)

44
—32

12
_—8

4 32(18] 8 |42
0 1{ol1]1]0]0

Thus (44),,=(101100),
Lab Activity:
Do ityourself

Chapter-4 Working with Flash

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick(¥) the correct option:

a) a) keyframes b) b) F6

c) c) F8 d) c¢) library

e) b) thearrowtool.



Fillin the blanks:

a) The Flash Workspace is the big white space
which is seen in the middle of the workspace.

b) The gray area surrounding the stage is known
as the keyframe.

c) Flash is a very powerful multimedia
software package developed by Macromedia.

d) The Flash is the arrangement of different
flash elements like the Tools panel, Control
panel, Property, Inspector and Windows.

Answer the following questions:

a) Thereare two kinds of gradients as follows:

(i) Linear Gradient : Italters colour from
the beginning point
to the end pointin a
straight line.

(ii) Radial Gradient : It alters colour n an
outward direction
beginning from the
focal point.

b) Two methods for the creation of an animation
in Flash are:

(1) TintTween

(i1) Shape Tween

c) There are four categories in Tools Panel as

follows:
(i) Tools : Theseareused fordrawing.
(ii) View : These incorporate tools

such as magnifier for
viewing.

(iii) Colors : These incorporate tools like
to fill colour with a colour
palette.

(iv) Options : This displays modifiers for
the selected tool. It affects
the editing options or tool's
painting.

The option of section of Tools Panels

displays anything from text to images and

shapes.

d) The default stage dimensions displayed on

the Flash Window are:

(1) Smallestsize : 1x1px (pixel)

(11) Largestsize : 2880x2880px (pixel)

e) By Tint Tweening, we mean that in our

animation, there would be several instances

in which an alteration in colour would be

required. Whether it would be to show or hide

an object, this technique can be utilized in

several ways.

f)  Stepstorotate afile, the steps are:

< Click on object to be selected or by
dragging a selection marquee around it.

% Click on Free Transform Tool on Tools
Panel.

< Click on Rotate/Skew Modifier button in
Options are of Tool Panel.

< Drag any corner handles on Confined
Box to rotate the shape. Drag handles
along the side to skew the object.

% Drag Circle Handle to alter
transformation point.

Lab Activity:
Do ityourself

Model Test Paper -1

1.

Tick (V') the correct option:

a) a) Binary b) ¢) Windows

c) a) software d) b) thearrowtool
e) c¢) library

Fillin the blanks:

a)  Actual Number System consists of 2 digits

b) The Back and Forward buttons are available
on the Toolbar.

c) All physical parts of the computer are called
hardware.

d) The gray area surrounding the stage is known
as the keyframe.

e) We can open Windows Explorer directly
from right clicking Start Button and then
Clicking on Open Windows Explorer.

Answer the following questions:

a) The Hexadecimal digits are base-16 number
system, because every position in number
represents an increasing number with a base
of 16.

They look same as Decimal Numbers upto 9,
but there are letters (“A”, ”B”, “C”, 'D”, “E”,
“F”’) in place of decimal numbers 10 to 15.

A single Hexadecimal digit can show 16
different values instead of normal 10 as
following:



Decimal

0123456789101112131415

Hexadecimal 0123456789ABCDEF

e)

d)

We can make Keyboard easier to use by
adjusting settings on Make Keyboard Easier
to Use page in Ease of Access Center.
Step1 : Click Start to Open Make
Keyboard Easier to use page
% Click Control Panel, Click
Ease of Access, Click Ease of
Access Center, Click Make
Keyboard Easier to use.
¢ Turn on Mouse Keys to run Mouse
keysifyoulogonto Windows.
< Turn on Sticky Keys: It sets
Sticky Keys to run.
< Turn on Toggle Keys: It plays
an alert every time you press
Caps Lock, Num Lock or
Scroll Lock keys.
< Turn on Filter Keys to enable
them to run.
< Underline Keyboard Shortcuts
& Access Keys to allows
access in Dialog boxes easier
by highlighting access keys for
control in them.
< Present Windows bring
automatically arranged when
moved to edge of Screen.
Input Unit is formed by Input Devices
attached with the computer. Input Devices
accept inputs in several forms from the user
and change it into understandable machine
form. Input Devices are: Keyboard, Mouse,
Scanner, Bar Code Reade, Joystic and Micro-
Phone.
Two methods for the creation of an animation
in Flash are:
(ii1) Tint Tween
(iv) Shape Tween
We use Documents Library to arrange and
organize word-processing documents,
presentations, spreadsheets and other text-
related files.
< Click Start button
< Click Documents.
We view a Window and its various parts help
us navigate or work with files, folders and
libraries.

Step 2

Chapter-5 Working with

Oral SKkills

1. Doityourself

Writing Skills

Multiple Choice Questions:

2. Tick(¥) the correct option:

a) c¢) Ctrl+loopplayback

b) c¢) OnionSkin

c) a) Timeline

d) c¢) Onion Skin

3. Fillin the blanks:

a) View, Guides and Grids, Show Grids are
selected to display the grids on the stage.

b) When we take an object out of the Library, the
object is referred to as importing image of a
symbol.

c) The Active Layer in the Timeline is indicated
with a Pencil Icon.

d) Layers are like paper sheets that may hold
objects and are stacked on top of each layer.

4. Answer the following questions:

a)

b)

d)

We will rename a Layer as follows:

7
0‘0

Double click Layer Name.

X3

S

Type anew name.

7
0‘0

Press Enter.

X3

S

Layer's name is altered.

In Flash, we can make layers which assist us
arrange and stack our artwork. Layers work
as clear pieces of film stacked on top of each
other. We can draw many sketches in layers.
The application of Onion Skin Tool is to
make frame-by-frame animations, making an
object in one frame and changing the object
slightly in next, and so on until we complete
the animation. It's tough to make these
animations when you can't see previous
frames. Onion Skins permit you to see
previous frames, working as a visual guide to
assist you draw the current frame.

We will delete a Layer by:

< Right clicking on Layer you wish to
delete.

Select Delete Layer.

X3

S

®,
0.0

The selected layer disappears from the
Timeline.



The steps to hide a layer are:

Y

< Click Black button beneath the eye icon
column.

7

< A Cross (x) marks the layer bullet and all
objects on the layer becomes invisible.

Lab Activity:
Doityourself

Chapter-6 Formulas and Functions in Excel

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick () the correct option:
a) b) Statistical b) a) Formula
c) b) Sort d) a) Custom Filter
3. Fillintheblanks:
a) Formula is an instant way to find out a set of
datainarange.
b) The pre-defined commands that do some
specific operations are known as Auto Sum,
Recently Used, Financial, Logical, Text,
Date & Time, Lookup & Reference, Maths
& Trig.
c) An absolute referencing is specified with '$'
sign.
4. Answer the following questions:
a) Datacanbestoredoutin many ways as
follows:
(1) By making a separate folder and saving
it.
(i1)) Bycommand Ctrl +S.
(111) By clicking on Save icon in Office
button.
b) Filtering is a process of finding data set in a

cell range at a fast speed. A filtered range

shows only those rows that meet all

conditions specified for a column. Filters can

be applied to a single range on a worksheet at

a time. Let us follows these steps to filter

data:

»  Click onacell to be filtered.

< Click on Data tab.

» Click on Filter in Sort & Filter group.
You see small arrows on each column

heading. -
|46

¢

-

-,

*e

B

< Click on arrow on required column
heading.

< Alist appears with all values selected by
default. You can choose desired value
and click on OK button.

The data gets filtered.

¢) IF is aconditional function that shows either

TRUE or FALSE as output. It shows first

value as an output if specified condition

evaluates to TRUE and second value if

condition evaluates to FALSE.

Syntax : =IF (condition, value if
TRUE, value if FALSE)
Examplel : =IF(A1>32,45,82)

It means that if the value in cell Al is greater
than 32, display 45 otherwise display 82 as an
output.
Example2 : = [F (A3=60, A3*20,
“SORRY”)
It means that if condition is true, calculate
A3*20 otherwise display output in form of
“SORRY ” text.

d) By Sorting, we mean arranging data in
ascending or descending order. MS Excel
2010 offers two options for sorting data.

» Selectcells in a worksheet.

< Click on the Data tab on Ribbon.

» Click on Sort A to Z (ascending order) or
Z. to A (descending order) in Sort &
Filter group.

Steps for sorting data based on various criteria are:

Select cell range.

Click on Data tab from Ribbon.

Click on Sort from Sort & Filter group.

Specify conditions on which data is to be

sorted in Sort dialog box.

(For example, Sort by: Total, Sort on: Values,

Order: Largestto Smallest).

< Click on OK button.

e) The applications of 'MIN', 'MAX' functions
are:

Min is used to display the smallest
(minimum) value in a range of cells as an

4

-

-,

*e

B

X3

8

X3

S

X3

8

X3

2

output.

Syntax  : = MIN (range or numbers).
Example : = MIN (Al:A6) gives as an
output.



Max is used to display the largest value in a
range of cells as an output.

Syntax : = MAX(range or numbers).
Example : = MAX (A1l:A6) gives an
output.

f)  Cell Referencing helps us to identify

behaviour of a cell address in a formula when
itis copied from one cell to another.
In MS Excel 2010, Cell Referencing is of 3
types — Relative Referencing, Absolute
Referencing and Mixed Referencing.
Every cell is made up of a column part and a
row part which is address of cell. Cell is
called relative when both parts are not fixed.
It is called absolute when both parts are
fixed. A cell is called mixed when only one
out of them is fixed.

Lab Activity:
Do ityourself

Chapter-7 Chart in Excel

Oral Skills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick(¥) the correct option:
a) b) Ctrl+P b) ¢) Dboth
c) a) Compact d) a) Cylinder
3. Fillin the blanks:
a) Cone and Cylinder are the examples of Pie
charts.
b) Charts are easier to compare and understand.
c) Insertdisplay columns with a pyramid shape.
d) Apicturedisplaying data is known as Chart.
4. Answer the following questions:

a) A pie chart displays data in a comparative
manner. It includes the size of things that
make up the data series to sum up items.

b) There is an option to resize and move a chart
in MS Excel 2010. Handle is the process used
to adjust a chart by dragging its frames:

+ In order to resize a chart in proportion, drag
the corner handle on the chart diagonally.

+ In order to move a chart, point anywhere
inside the chart and drag it in the required
direction.

d)

A Chart is a visual representation of data. We
can represent numerical data in graphical
formats. This representation is called Chart
or Graph. The main components of a chart
include Plot Area, Value Axis, Category Axis,
Data Points, Chart Area and Legend.

We can display information using various

types of charts such as:

1) ColumnChart : It is used either to
display data changes
or to compare different
items.

2) PieChart : It displays data in a
comparative manner.
It includes size of
things that make up
data series to sum up
items.

3) Bar Chart : Itdisplays comparison
among individual
items.

4) LineChart : It displays changing
trends in data at equal
intervals. It represents
data in form of
different lines which
vary atequal intervals.

:These include
Surface, Doughnut,
Bubble and Radar
Charts.

: It displays changes in
values over a period
or categories.

5) Other Charts

6) AreaChart

7)  Scatter Chart : It displays pairs of
values in a scatter
format.

We can delete the data from a chart by

selecting the data and then pressing the

Delete option.

We can alter the chart type using the Design

Tab:

Step1 : Double click on the chart. You can
see the Design tab. It contains
charttools.

Step2 : Click on Change Chart Type from
the Type Group.



Step3 : Select the new Chart Type and
subtype from the Change Chart
Type dialog box.

Step4 : Click onthe OK button.

f)  We can briefly explain Pie Chart, Line Chart

and Column Chart as follows:

1) PieChart : It displays data in a
comparative manner.
It includes size of
things that make up
data series to sum up
items.

: It displays changing
trends in data at
equal intervals. It
represents data in
form of different
lines which vary at
equal intervals.

3) ColumnChart: It is used either to

display data changes

2) Line Chart

or to compare
different items.

Lab Activity:

Doityourself

Chapter-8 Computer Virus

Oral Skills

1. Doityourself

Writing Skills

Multiple Choice Questions:
2. Tick (v) the correct option:
a) c¢) biological b) a)
c) b) infects d) ¢
3. Fillin the blanks:
a) Virus multiplies on the computer by
producing copies of itself.

commonly
four

b)  Virus can damage your floppy disk contents.

c) Every virus has a unique event associated
withit.

d) A virus may be introduced to computer
system along with any software program.

4. Answer the following questions:

a) Resident virus definition applies widely to
any type of virus which inserts itself into a
system's memory.

b) A Logic Bomb is a programme that is
executed only when a particular condition is
met. The virus: Friday the 13" was
programmed so as to get executed on that
specific date.

c) Hackers signify those people who use their
skills to enter into computer systems without
any authorization. They are computer
enthusiasts who break down into secure
systems to get information about others and
most probably use this information to play
pranks.

d) Network Virus is a type of virus which
spreads across networks in computers. For
example, SQL Slammer and Nimda worms
are viruses which spread over corporate
networks via e-mails.

e) A cracker is a malicious programmer who
receives unauthorized access to computer
systems for the purpose of stealing,
corrupting or altering information.

Lab Activity:
Do ityourself

Chapter-9 Working with QBasic

Oral SKkills
1. Doityourself
Writing Skills
Multiple Choice Questions:
2. Tick (v) the correct option:
a) c¢) number b) a) decimal
c¢) b) particular d) a) two
3. Fillin the blanks:
a) QBasic is a simple programming language
for beginner programmers.
b) Keywords in QBasic contain specific
meanings.
c) Keywords are also known as Reserved
words.
d) The data may be a letter words, numbers or
special characters.
4. Answer the following questions:

a)  Constants are known as the data or the values in
aprogram that cannot be altered during program
execution. The data may be a letter, words,
numbers or special characters. They are:



b)

d)

(1) String Constant

(i1)) Numeric constant

String Constant is a letter, words, numbers,

combination of letters with numbers or

special characters enclosed in double quotes.

Mathematical operations cannot be carried

out on String Constant.

“B', “APPLE”, “SYMBOL NO: 10205, “!!!

Welcome to QBASIC Word !!!”, etc. are

some of the examples of String Constants.

Numeric Constant signifies to a number. A

number with or without decimal point is

called a Numeric Constant. Thousands
separators are not allowed to utilize in

Numeric Constant. The numeric data must

not be enclosed in double quotes: 101,

105.50, 720, 45603, etc. are some of the

examples of Numeric Constants.

A variable is a place in computer memory

containing a name and stores data

temporarily. Every program defines various
numbers of variables. A value of a variable
can be altered during execution of program.

There are mainly 2 kinds of variables:

(i) String Variable : It stores data.
Dollar ($) is its
types declaration
sign.

(ii) Numeric Variable : It stores numeric
data. A numeric
variable can be
Integer, Long
Integer, Single
Precision or
Double Precision
variables.

CLS Statement: It is a command utilized to

clear the output screen. When we run a

program maintaining the CLS command, it

clears the output screen.

Print “This is to show the use of CLS

command.”

CLS

Print “The earlier output has been

disappeared.”

Lab Activity:
Do ityourself

2.

3.

Model Test Paper - 11

Tick (V') the correct option:

a)
c)

a) Timeline b) b) infects

a) Cylinder d) a) decimal

Fillin the blanks:

a)
b)
c)

d)
e)

The Active Layer in the Timeline is indicated
with a Pencil Icon.

An absolute referencing is specified with '$'
sign.

Every virus has a unique event associated
withit.

Insert display columns with a pyramid shape.
Keywords are also known as Reserved
words.

Answer the following questions:

a)

b)

We will delete a Layer by:

< Right clicking on Layer you wish to
delete.

Select Delete Layer.

The selected layer disappears from the
Timeline.

X3

S

X3

o8

By Sorting, we mean arranging data in
ascending or descending order. MS Excel
2010 offers two options for sorting data.

> Select cells ina worksheet.

» Click on the Data tab on Ribbon.

» Click on Sort A to Z (ascending order) or
Z to A (descending order) in Sort &
Filter group.

Steps for sorting data based on various

criteria are:

>

*

*,

¢

-,

)

B3

7

< Selectcell range.

Click on Data tab from Ribbon.

Click on Sort from Sort & Filter group.
Specify conditions on which data is to be
sorted in Sort dialog box. (For example,
Sort by: Total, Sort on: Values, Order:
Largest to Smallest).

< Click on OK button.

Hackers signify those people who use their
skills to enter into computer systems without
any authorization. They are computer
enthusiasts who break down into secure
systems to get information about others and
most probably use this information to play
pranks.

7
0‘0

X3

o8

X3

S



d)

We can delete the data from a chart by
selecting the data and then pressing the
Delete option.

A variable is a place in computer memory

containing a name and stores data

temporarily. Every program defines various
numbers of variables. A value of a variable
can be altered during execution of program.

There are mainly 2 kinds of variables:

(i) String Variable : It stores data.
Dollar ($) is its
types declaration
sign.

(ii) Numeric Variable :

Activity:

a. Doityourself
b. Doityourself
Project Work:

Do ityourself

It stores numeric
data. A numeric
variable can be
Integer, Long
Integer, Single
Precision or
Double Precision
variables.



